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1. Introduction 

1.1. What is Engrenarium 

 

Engrenarium is an interactive tool for modeling, visualization, and kinematic analysis of plan-

etary gear systems. The program allows users to build simple or multi-stage assemblies, define 

known speeds, create couplings between components, calculate speed ratios, and observe system 

behavior through a 3D visualization. 

In practice, the software was designed to support both educational use and technical explora-

tion. This means it is well suited for classroom demonstrations, individual study, comparison be-

tween transmission arrangements, and the construction of classic examples of planetary gear sys-

tems. 

 

 
Figure 1 – Engrenarium home screen 

 

Engrenarium can be used in different contexts. For students, it helps relate the theory of 

planetary gears to a visual and interactive model. For instructors, it serves as a teaching aid, as it 

facilitates the demonstration of inputs, outputs, constraints, and couplings. For users with a more 

technical focus, it also works as a conceptual verification tool before more advanced design stages. 

 

 Build a simple planetary gear set to study basic relationships; 

 Compare different combinations of input, output, and fixed elements; 

 Assemble multi-stage systems; 

 Test couplings between components from different stages; 

 Visualize the assembly in 3D and interpret the calculated results. 
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1.2. Nomenclature and basic concepts 

 

Before starting to use the program, it is important to establish the terminology of the main 

components. Engrenarium uses the most common names in its interface and organizes each plane-

tary system based on four main elements. 

 

 Sun gear: Central gear of the assembly; 

 Planet gear: Gear that rotates around the sun gear and typically meshes with the ring gear; 

 Ring gear: Outer gear with internal teeth; 

 Carrier: Component that holds the planet gears and defines the rotation of the carrier. 

 

 
Figure 2 – Components of a planetary gear set 

 

Throughout the software, these elements are associated with other basic concepts, listed be-

low: 

 

 Angular velocity: The speed at which a gear rotates about its own axis; 

 Speed ratio: The ratio between input speed (usually from the motor) and output speed of 

two gears; 

 Coupling: A way to connect components from different planetary systems, making their 

angular velocities equal. 

 

1.3. General Workflow in Engrenarium 

 

O fluxo de uso do Engrenarium segue uma sequência lógica. Essa sequência é importante 

porque o programa separa claramente a definição geométrica da definição cinemática. 

 

I. Create a new project or open an existing one; 

II. Define the basic parameters of the planetary stage(s); 

III. Enter known speeds and, when necessary, add couplings; 

IV. Select the speed ratio to be observed; 

V. Check the 3D rendering and interpret the calculated results; 

VI. Save the project or export the assembly as needed. 

 

By following this order, the user reduces the likelihood of leaving the system underdeter-

mined, overdetermined, or geometrically inconsistent.  
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2. Engrenarium interface 

 

2.1. Overview of the main window 

 

The main window of Engrenarium was designed so that input data is placed on one side, the 

assembly visualization is highlighted, and the calculated results remain accessible at the same time. 

In practical terms, the interface consists of a top command area, a data panel, a rendering area, and a 

results panel. 

 

 
Figure 3 – Engrenarium areas 

 

 Menu bar: General commands such as file, tools and help; 

 Input data panel: Gathers sections for basic parameters, speeds, couplings, ratios, and gear 

data; 

 Toolbar: Quick access to the most commonly used commands; 

 Rendering area: Displays the planetary assembly in 3D at real speed; 

 Results panel: Shows calculated ratios, angular velocities in rpm, and error or inconsisten-

cy messages. 

 

2.2. Menu bar 

 

2.2.1. File: 
 

New: 

Creates a new project. 

 

Open: 

Opens a previously saved project. Engrenarium uses files with the .engr extension. 

 

Save, Save As: 

Allows saving the created project. The number of teeth, velocities, couplings, results, data, 

etc. are saved. 
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Export: 

Allows exporting the model to STL and DXF 3D files. 

The export generates ZIP-compressed files based on the meshes created by the editor. This 

feature is intended for transferring geometry to other tools. When the final goal is manufacturing, 

the exported model should be treated as a working base rather than a final production file. 

The project is saved as multiple files, with a separate file for each component. 

 

Save video: 

Engrenarium allows saving videos of the rendering window with a time limit of 600 seconds. 

During recording, the editor displays a visual indicator with the elapsed time and allows cancella-

tion. 

 

 
Figure 4 – Save vídeo window 

 

The available video formats are .webM and .avi. For each format, it is possible to choose be-

tween: 

 

 Standard quality (720p, low bitrate); 

 High quality (1080p, high bitrate). 

 

There are two options for the video capture area. The first is the current window, where the 

user can manually adjust the final size. The second is a 16:9 area; the software creates the video 

from a central area with that aspect ratio. 

If the Record from start option is selected, the planetary gear simulation resets before start-

ing the video; otherwise, the video begins from the current moment. 

 

Engrenarium does not include a built-in codec. For .webM videos, no codec installation is re-

quired, and the video will be saved with the selected quality. 

For .avi videos, installing a codec is necessary to achieve good quality. Windows includes a 

native codec called Microsoft Video 1 (MSVC), which produces very low-quality videos. The 

x264vfw codec produces high-quality videos, is free, and can be installed from the link below. After 

installation, restart Engrenarium so it can recognize the codec. The default settings should be 

enough for video creation. 

 

https://sourceforge.net/projects/x264vfw/ 

 

 

https://sourceforge.net/projects/x264vfw/
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Examples: 

Engrenarium provides four examples so that the user may explore planetary gear systems of 

varying complexity and their associated features. 

 

 
Figure 5 – Examples window 

 

Preferences: 

It is possible to modify several parameters related to units, components, windows, languages, 

and others, according to the user’s needs and preferences. 

 

 
Figure 6 – Preferences window 

 

Under Units, it is possible to select millimeters or inches, the fundamental gear parameter 

(module or diametral pitch), the decimal separator dot ( . ) or comma ( , ), and the number of dec-

imal places. 
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Under Parts, there are options for metallic colors or solid colors for the appearance of the 

gears. 

In this tab, it is also possible to enable or disable the parts list displayed in the rendering 

window. 

The option Export visible parts only allows that, when a component is hidden in the parts 

list, it is not exported to STL or 3D DXF. In multi-stage planetary systems, this can result in signifi-

cantly smaller file sizes. 

 

 
Figure 7 – Gear appearance options 

 

Under Windows, it is possible to modify the layout of the Engrenarium windows, with the 

options Fixed windows and Floating windows. 

With fixed windows, it is possible to manually adjust the height and width of the windows, 

but they remain fixed in place. 

With floating windows, it is possible to reposition the windows by dragging them according 

to the user’s preference. 

 

 
Figure 8 – New layout based on the Floating windows option 
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Under Language, the user may change the software language. Currently, Engrenarium sup-

ports English and Brazilian Portuguese. 

 

Under Other, there is an option to select between light and dark themes. 

It is also possible to choose the viewing camera, with the options Orthographic projection 

and Perspective projection. Orthographic projection is more neutral for visual dimensional analy-

sis, while perspective projection tends to provide a more intuitive spatial perception. 

 

 
Figure 9 – Comparison between orthographic projection (left) and perspective projection (right) 

 

2.2.2. Tools: 

 

The options available under the Tools menu are listed below: 

 

 Add planet; 

 Add angular velocity; 

 Add planetary; 

 Add coupling; 

 Add speed ratio; 

 Save data; 

 Gear data. 

 

Refer to section 2.4. Toolbar for a detailed description of each item. 

 

2.2.3. Help: 

 

User Guide: 

Opens a PDF containing this guide. 

 

License: 

The License window indicates whether the user’s license is Free or Pro. From this window, it 

is possible to purchase the Pro license (the user is redirected to an external website for the purchase) 

and to activate the Pro license using a license key received directly via email. 

The Pro license has perpetual validity, granting access to all future updates of Engrenarium. 

In case of issues with the license, please make contact for resolution. 

 

About: 

This window displays information such as the current version and a contact email address. 

The Check for updates button allows the user to manually check for software updates. 
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2.3. Input data panel 

 

The data panel is the input interface of Engrenarium. It is divided into collapsible sections, 

each with a specific function. 

 

 
Figure 10 – Input data panel 

 

2.3.1. Basic parameters: 

 

Defines the number of teeth of the sun gear, planet gears, and ring gear, as well as the number 

of planets in orbit. 

The user may create assemblies without the sun gear and/or without the ring gear. 

The + Planet button allows the addition of more planet gears within the same planetary stage. 
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Figure 11 – Example of a planetary system with two planet gears in series 

 

Engrenarium uses different approaches to enable the simulation of planetary gear systems. 

For the case in which there is only one set of planet gears, the calculation required to allow 

simulation is: 

 

2sr pN N N                        (1) 

 

Nr – Number of teeth of the ring gear; 

Ns – Number of teeth of the sun gear; 

Np – Number of teeth of the planet gear. 

 

If Equation 1 is not satisfied, the simulation is halted and an error message is displayed indi-

cating the required value of Nr for correction. Alternatively, modifying Ns or Na is also possible. 

 

 
Figure 12 – Example of an impossible assembly and the corresponding error message 

 



12 

For the case in which there are two or more planet gears in series, the calculation changes to: 

 

2s pr iN N N                        (2) 

 

Np i – Number of teeth of the planet gear i. 

 

Note that Equation 2 uses the symbol ≤. This occurs because Engrenarium allows situations in 

which the planet gears are not aligned in a straight line, resulting in a bent carrier. 

 

 
Figure 13 – Example of planet gears in series with a bent carrier 

 

2.3.2. Angular velocities 

 

Engrenarium uses only the unit of angular velocity in revolutions per minute (rpm), creating 

a real-time simulation in the rendering window. However, it is possible to modify the time scale of 

the rendering using the Time scale slider in the Results panel. 

By default, Engrenarium considers counterclockwise rotations as positive values and clock-

wise rotations as negative values. 

 

2.3.3. Couplings 

 

The couplings panel appears only when the system has two or more planetary stages. In this 

case, at least one coupling is required. 

Coupling allows the connection of two planetary systems, ensuring that the coupled compo-

nents have equal angular velocities. 

When a new planetary stage is added to the system, the number of required inputs increases, 

such as speeds and couplings. Engrenarium indicates how many speeds or couplings are required 

for the system to cease being underdetermined so that the simulation can be performed. 

If the user defines too many speeds and couplings, the software displays a message indicating 

that the system is overdetermined, requesting the removal of a certain number of boundary condi-

tions. 

If the user defines contradictory conditions, the software also indicates that the system is 

overdetermined, but does not specify which condition caused the error. It is up to the user to identi-

fy the contradiction. (An example of contradiction is a coupling connecting Planetary 1 - Sun with 

Planetary 2 - Sun while the user sets the speed of Sun 1 = 0 and the speed of Sun 2 = 10) 
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Figure 14 – System with two planetary stages and the underdetermined system error message 

 

When couplings are created, the software rendering displays a connection between the two 

coupled components. When the project is exported, the coupled components are exported as a single 

part. 

 

 
Figure 15 – Rendering of different couplings 

 

2.3.4. Speed ratio 

 

As explained in section 1.2, the speed ratio is the ratio between the input speed (usually from 

the motor) and the output speed of two gears. 

When the gears are selected, the calculation is displayed in the Results panel. It is possible to 

select different ratios, and all of them are shown in the Results panel. 
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2.3.5. Gear data 

 

The gear data panel allows the modification of different gear parameters with the purpose of 

adjusting the final model for potential export. The parameters that can be modified do not affect the 

calculated speeds or speed ratios. 

 

 
Figure 16 – Gear data panel with default values 

 

Changing the pressure angle modifies the tooth profile of the gears; standard values are 

14.5°, 20°, and 25°. Helix angle values greater than zero convert spur gears into helical gears. 

Engrenarium allows modification of the widths of its components. All gears within a plane-

tary stage have equal widths; therefore, changing this value applies to all components. 

The ring gear includes an additional editable dimension, namely its thickness, allowing the 

creation of a more robust and resistant component. 

 

 
Figure 17 – A) Different pressure angles. B) Gears with helix angles of 0° and 30°. 

C) Increased gear width. D) Different ring gear thickness values. 
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The module (or diametral pitch) of the gears may appear, at first glance, not to modify the 

geometry of the planetary assemblies. However, planetary stages with different modules produce 

gears of different sizes, even when they have the same number of teeth. Furthermore, since the pitch 

diameter of a gear follows the formulas below, when exporting the project to STL or DXF, the gear 

sizes will follow the same principle. 

 

D mN                       (3) 

 

d

N
D

P
                       (4) 

 

D – Pitch diameter; 

m – Module; 

Pd – Diametral pitch. 

 

The distance between stages is disabled when the project contains only one stage. When 

there is more than one planetary stage, it is possible to modify the distance between them by adjust-

ing this parameter. 

 

 
Figure 18 – Same project with two stages and different distances between them 

 

The Backlash option reduces the thickness and height of the teeth. The maximum clearance 

value is equal to the gear module. There is also an option to apply clearance only to the planet 

gears. 

It is recommended to apply a non-zero clearance value for those who intend to 3D print the 

gears, in order to reduce issues related to manufacturing tolerances. 

 

 
Figure 19 – Comparison between gears without and with clearance 
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Engrenarium operates with standardized addendum and dedendum values; however, the teeth 

depth option allows the parameter to be adjusted to reduced-depth teeth, in which the addendum 

and dedendum values are 20% smaller. 

 

 
Figure 20 – Standard and reduced tooth depth 

 

By default, Engrenarium has the profile shift option enabled, which modifies the tooth profile 

with a trochoidal curve to avoid interference. This option can be disabled if desired by the user. 

 

 
Figure 21 – Same gear with the profile shift option enabled and disabled 

 

When the project contains multiple planetary stages, the user has the possibility of creating 

stages with identical or different gear data. When the option Same data for all planetaries is disa-

bled, the Gear data panel displays additional parameter columns. 

 

 
Figure 22 – Planetary stages with different gear data 
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2.4. Toolbar 

 

The toolbar was designed to speed up the user’s workflow. Instead of searching for each ac-

tion in the menu, it is possible to directly access the main commands through the icons below. 

 

 
Figure 23 – Toolbar 

 

Table 1 – Description of toolbar icons 

Icon Name Function 

 

New project Creates a new project; 

 

Save Saves the current project; 

 

Open Opens a project; 

 

Undo Undoes the last action; 

 

Redo Redoes the last undone action; 

 

Front view Sets the planetary system to a front view; 

 

Fit to screen 
Adjusts the zoom to fit the entire planetary 

system within the rendering area; 

 

Add planet 

Adds a planet gear. In the case of multiple 

planetary stages, a list is displayed to select the 

stage where the planet gear will be added; 

 

Add angular velocity 
Adds a new angular velocity entry in the input 

data panel; 
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Add planetary 
Adds a new planetary stage to the current pro-

ject; 

 

Add coupling 
Adds a new coupling field in the input data 

panel; 

 

Add speed ratio 
Adds a new speed ratio field in the input data 

panel; 

 

Save data 
Saves the current input data in a side panel 

within the rendering area; 

 

Gear data Opens a window with the gear parameters. 

 

Some of the commands listed in Table 1 are self-explanatory. For those that require further 

clarification, additional details are provided below. 

 

2.4.1. Add planet 

 

The add planet function always inserts a planet gear after the last existing one. In projects 

with multiple planetary stages, a list is displayed so that the user can select the stage in which the 

planet gear should be added. 

 

 
Figure 24 – List of planetary stages for adding a planet gear 

 

2.4.2. Add angular velocity 

 

By default, Engrenarium provides two angular velocity input fields for the user. The Add 

speed button creates an additional field in the input data panel. 

This option is useful when the user has multiple planetary stages in a project and needs to add 

more boundary conditions for a proper simulation. 
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Figure 25 – Additional speed field after selecting Add speed 

 

2.4.3. Add planetary 

 

When clicking Add planetary, a new planetary stage is added to the project with the same 

data as the previous stage. The data panel displays an additional field in the Basic parameters sec-

tion so that the user can modify the number of teeth as desired. 

After adding a new planetary stage, the software labels each stage as Planetary 1, Planetary 2, 

etc., in order to distinguish them when selecting speeds, couplings, and other parameters. 

When there are two or more planetary stages, they can be removed using the Remove button 

next to the stage name. 

 

 
Figure 26 – Basic parameters panel with two planetary stages and their names 

 

2.4.4. Add coupling 

 

The Add coupling button appears only when the system contains two or more planetary stag-

es. In this case, at least one coupling is required. The coupling allows the connection of two plane-

tary systems, ensuring that the coupled components have equal angular velocities. When couplings 

are created, the software rendering displays a connection between the two coupled components. 

When the project is exported, the coupled components are exported as a single part. 
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In order for the connection between two planet gears from different stages to appear, certain 

conditions must be satisfied: 

 

 There must be a coupling between the carriers of the two planetary stages; 

 The distances from the center of the planetary stage to the center of the planet gear must be 

equal in both stages. 

 

Engrenarium verifies this distance in millimeters (or inches), and planetary stages with differ-

ent modules (or diametral pitches) may still satisfy the conditions required for coupling between 

planet gears. 

 

 
Figure 27 – Coupling between planetary stages with different modules 

 

When there is coupling between planet gears, the number of planets in orbit remains the same 

across all stages. If the user changes the number of planets in orbit in one planetary stage, this 

change is automatically applied to the other stage. 

 

2.4.5. Add speed ratio 

 

Engrenarium calculates one speed ratio by default. When additional ratios are added, a new 

input and output field appears in the input data panel. The results panel displays all ratios, following 

the simple formula: 

 

Speed

ratio

input

output




                              (5) 

 

ωinput – Input angular velocity; 

ωoutput
 – Output angular velocity. 

 

 
Figure 28 – Multiple input and output fields for speed ratios 
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2.4.6. Save data 

 

For a given planetary system, it is possible to modify velocities, couplings, and input/output 

relationships, resulting in completely different outcomes. Engrenarium provides the ability to save 

these different scenarios so that the user can switch between them quickly. 

When clicking Save data, a panel appears on the side of the rendering window containing the 

saved data. It is possible to edit the panel title as well as the title of each saved configuration. 

 

 
Figure 29 – Rendering window with panel created by Save data 

 

The simplest way to understand the importance of this feature is by examining the saved ex-

amples under File → Examples. The example Allison 1000 Automatic Transmission presents an 

automatic transmission used in several vehicle models, in which the Save data panel is used to dis-

play different gear states, demonstrating how boundary conditions and speed ratios produce differ-

ent results for a real system. 

 

 
Figure 30 – Allison 1000 Automatic Transmission example 

 

2.4.7. Gear data 

 

The Gear data button opens a window that displays the same options as the Gear data panel 

located on the left side of the input data panel. 

For details about this window, refer to section 2.3.5. Gear data. 
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2.5. Rendering area 

 

The rendering area displays the constructed assembly in three dimensions. It is where the user 

verifies whether the assembly corresponds to what was defined in the data panel. 

The mouse controls for manipulating the model are: 

 

 Left button – Rotates the planetary system; 

 Scroll wheel – Zooms in or out; 

 Right button – Translates the planetary system. 

 

The keyboard controls for manipulating the model are: 

 

 Arrow keys – Translate the planetary system; 

 Ctrl + arrow keys – Rotate the planetary system. 

 

In addition to the main model, this area may display auxiliary panels, such as the list of saved 

configurations described in section 2.4.6. Save data. 

When the parts list is enabled, the rendering also displays a panel on the left side containing 

the list of rendered components. The list is organized by planetary stages, and within each stage, 

each component is shown with its respective name. 

This parts list feature also allows components to be hidden or shown, including the option to 

hide an entire planetary system at once. Hiding a component does not affect the results. 

When the option Export visible parts only is enabled (File → Preferences → Parts), hidden 

components in the parts list are not exported to STL or 3D DXF. 

 

 
Figure 31 – Rendering area with the parts list. Note that some components are hidden. 

 

2.6. Results panel 

 

The results panel displays the kinematic output calculated by the software. When the system 

is properly defined, the user can observe the speed ratios and the velocities of each component in 

revolutions per minute (rpm). 

In the case of multiple planetary stages and multiple speed ratios, the panel organizes the re-

sults in the order defined in the input data panel. 



23 

 
Figure 32 – Results panel with two planetary stages and two speed ratios 

 

In situations where a planetary stage has an impossible combination of tooth numbers, the re-

sults panel displays a message indicating the required number of teeth for the ring gear to correct 

the issue (see Figure 12). Alternatively, adjusting the number of teeth of the sun gear or the planet 

gear can also resolve the error and remove the message. 

When there is a problem in the definition of boundary conditions, the panel displays messages 

indicating whether information is missing (underdetermined system) or whether there are exces-

sive constraints (overdetermined system). 

 

 
Figure 33 – Examples of error messages 

 

The results panel also includes a manual Time scale control. Since Engrenarium renders the 

simulation in real time, in some cases the velocites may be too high or too low for comfortable vis-

ualization. Therefore, it is possible to adjust the time scale without affecting the calculated results. 

The time scale ranges from a minimum of 0.1 to a maximum of 10.  
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3. Examples of assembling a planetary system 

 

3.1. Single-stage planetary system with two ratios 

 

Open a new project. In the Basic parameters panel, click the + Planet button to add an addi-

tional planet gear to the system. Then, set the following tooth numbers: 

 

 Solar: 40; 

 Planet 1: 15; 

 Planet 2: 15; 

 Ring: 100. 

 

Under angular velocities, set: 

 

 Solar: 10,0 rpm; 

 Ring: 10,0 rpm. 

 

Under Speed ratio, set: 

 

 Input: Solar; 

 Output: Carrier. 

 

The results panel should display the following values: 

 

Ratio 1: Sun/Carrier: 1.0. 

 

Angular velocities: 

 Solar: 10,0 rpm; 

 Planet 1: 10,0 rpm; 

 Planet 2: 10,0 rpm; 

 Ring: 10,0 rpm; 

 Carrier: 10,0 rpm. 

 

 
Figure 34 – First ratio of Example 3.1 
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Now click the Save data button . This will store the speeds for later retrieval. In the 

panel that appears in the rendering area (upper right corner), click the pencil icon next to Title and 

type CVT Transmission, then press Enter. Next, click the pencil icon next to Ratio 1 and type 

Forward gear, then press Enter. 

 
Figure 35 – Saved data panel 

 

Now modify the ring speed: 

 

 Ring: 0 rpm. 

 

The results panel should display the following values: 

 

Ratio 1: Solar/Carrier: - 1,5. 

 

Angular Velocities: 

 Solar: 10,0 rpm; 

 Planet 1: - 51,1 rpm; 

 Planet 2: 37,8 rpm; 

 Ring: 0,0 rpm. 

 Carrier: -6,7 rpm 

 

Click the Save data button, then click the pencil icon next to Ratio 2 and type Reverse gear. 

By clicking on Ratio 1 and Ratio 2, the system returns to the respective boundary conditions. 

 

 
Figure 36 – Example 3.1 with two saved gears 

 

This example demonstrates how a CVT transmission modifies its boundary conditions to 

move the vehicle forward and to engage reverse. 
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3.2. Two-stage planetary system 

 

Open a new project. In the Basic parameters panel, set the following tooth numbers: 

 

 Solar: 20; 

 Planet: 28; 

 Ring: 76. 

Now click the Add planetary stage button . Note that the simulation stops and the fol-

lowing message appears: “Error: The kinematic system is underdetermined. Add 2 more known 

velocities or couplings.” 

 

In Planetary 2, click the X button next to Sun to remove the sun gear. Then set the following 

tooth numbers: 

 

 Planet: 30; 

 Ring: 78. 

 

Under angular velocities, set: 

 

 Planetary 1 - Solar: 10,0 rpm; 

 Planetary 1 - Carrier: 5,0 rpm. 

 

Under Couplings, set: 

 

 Planetary 1 - Carrier | Planetary 2 - Carrier 

 Planetary 1 - Planet | Planetary 2 - Planet 

 

Under Speed ratio, set:: 

 

 Input: Planetary 1 - Solar; 

 Output: Planetary 2 - Ring. 

 

The results panel should display the following values: 

 

Ratio 1: Planetary 1 - Sun / Planetary 2 - Ring: 2.8. 

 

Angular velocities: 

Planetary 1: 

 Solar: 10,0 rpm; 

 Planet: 1,4 rpm; 

 Ring: 3,7 rpm. 

 Carrier: 5,0 rpm 

Planetary 2: 

 Planet: 1,4 rpm; 

 Ring: 3,6 rpm. 

 Carrier: 5,0 rpm 
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Figure 37 – Example 3.2 with two planetary stages 

 

Some aspects of this example are noteworthy. Observe that the planetary system does not re-

quire all components to function, as in Planetary 2 where the sun gear is absent. 

Another important point concerns the conditions required for coupling between planetary 

stages. Two couplings were established, ensuring that the carriers and planet gears of both stages 

have equal angular velocities. A coupling only between carriers leaves the system underdetermined, 

since it is physically possible for the carriers to share the same angular velocity while the planet 

gears of Planetary 1 have different velocities from those of Planetary 2. Therefore, coupling be-

tween planet gears is also essential. 

Also note that, in the rendering, the carrier of Planetary 2 is no longer visible. Due to the cou-

pling between carriers, the rendering is adjusted to correctly connect the stages, with the shafts of 

the carrier of Planetary 1 extending to engage the planet gears of both stages. 

 

 
Figure 38 – Carrier of Planetary 1 with extended shafts 
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4. Free e Pro Features 

 

The Free version covers essential usage, while the Pro version adds advanced capabilities, 

broader deployment options, and licensing plans for individuals and institutions. 

The Pro version unlocks the following features: 

 

 Export of 3D models in STL and DXF formats; 

 Export of simulation videos in AVI and WebM formats; 

 Ability to save projects; 

 Ability to store multiple operating conditions within a project, such as different gear states 

or gear ratios; 

 Support for multiple selectable gear ratios. The Free version allows only one; 

 Support for an unlimited number of planetary stages in a model. The Free version allows 

up to two; 

 Support for an unlimited number of planet gears per planetary stage. The Free version al-

lows up to two planets per stage; 

 Ability to modify fundamental gear geometry parameters, including module, pressure an-

gle, and helix angle; 

 Ability to define independent gear parameters for each planetary stage. 


